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This operating manual contains important instructions for safe
and efficient handling of the Digta (hereinafter referred to as
“device”). This operating manual is part of the device and
must be kept accessible in the immediate vicinity of the device
for persons working on and with the device. Carefully read
and make sure you understand this operating manual and all
product safety labels prior to starting any work with the device.
The basic prerequisite for safe work is compliance with all speci-
fied safety and handling instructions. In addition, all local acci-
dent prevention guidelines and general safety regulations effec-
tive at the implementation site of the device apply. lllustrations in
this operating manual are provided for basic understanding and
can vary from the actual model of the device. No claims can be
derived from the illustrations in this operating manual.

Disclaimer

All information and instructions in this operating manual have
been provided under due consideration of applicable guidelines
and regulations, the current and known state of the art, as well
as our many years of in-house experience. The manufacturer
assumes no liability for damages due to:

— Failure to comply with the instructions in this operating
manual

— Improper use / misuse

— Willful operation by non-authorized persons

— Unauthorized conversions or non-approved technical modi-
fications

— Use of non-approved spare parts

The originator is solely liable to the full extent for damages caused
by such conduct. The agreed upon obligations in the delivery con-
tract, the general terms and conditions, the manufacturer’s deliv-
ery conditions, and the statutory regulations valid at the time the
contract was concluded, apply.



Copyright

This operating manual is protected by copyright. No part of this
operating manual may be reproduced in any form or incorporat-
ed into any information retrieval system without written permis-
sion of Grundig Business Systems GmbH (“the Manufacturer”).
Delivery of the operating manual to third parties, duplication in any
form - including excerpts - as well as exploitation and/or commu-
nication of the content, are not permitted without a written decla-
ration of release from the manufacturer. Actions to the contrary
make damage compensation mandatory. We reserve the right to
enforce additional claims.

The manufacturer

© Grundig Business Systems GmbH
WeiherstraBe 10
D-95448 Bayreuth

holds the copyright.
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EXPLANATION OF SIGNALWORDS AND
SYMBOLS

Before using your new dictation machine, read this manual carefully to
ensure that you know how to operate it safely and correctly. Keep this
manual in an easily accessible folder on your PC (or a printed version
in an easily accessible location) for future reference.

Explanation of signalwords and symbols

Certain symbols are used in the user's manual and on this product to
help protect users, their surroundings, and their property from possible
injury or damage. Please familiarize yourself with the following defini-
tions and meanings for each symbol before reading the precautions.

A DANGER

DANGER indicates a hazardous situation which, if not avoided,
will result in death or serious injury.

A WARNING

WARNING indicates a hazardous situation which, if not avoided,
could result in death or serious injury.

A CAUTION

CAUTION, used with the safety alert symbol indicates a hazardous
situation which, if not avoided, could result in minor
or moderate injury.

0 IMPORTANT

Indicates specific actions which prevent from damage of the device
and prevent from loss of dictations or other data.

Indicates specific actions which may be useful but may result in loss
of dictations or other data.

I HinT NOTE
Emphasizes tips and information.



GENERAL PRECAUTIONS

Intended use

This digital portable dictation machine is designed to record and play
back dictations. Any other use is considered improper and not permitted.

Special hazards

A WARNING

Danger of accidents!

Do not use the device while operating vehicles (such as cars, bicycles,
motorcycles, ATVs, etc.).

Disregarding this precaution can lead to traffic accidents.

A CAUTION

Risk of injury!
Do not leave the device unattended and use it with extreme caution if
children or persons who cannot assess the dangers are nearby.

Keep the device away from persons (including children) who are unable
to use it safely due to their physical, sensory or mental limitations, lack
of experience or lack of knowledge.

Disregarding these precautions means risking injury.

0 IMPORTANT

Protect your machine from exposure to moisture (rain, splashing lig-
uids). Never lay your dictation machine down near a heater or directly
into sunlight.

Use a dry cloth to clean the machine. Do not use chemical cleaning
agents.

You must not open the dictation machine under any circumstances.
Opening the machine will invalidate the warranty repair. Open only the
lid to the compartment of the rechargeable battery.

Do not disassemble, repair or modify the unit yourself.
Avoid recording or playing back near cellular phones or other wireless
equipment, as they may cause interference and noise. If you experi-

ence noise, move to another place, or move the recorder further away
from such equipment.



GENERAL PRECAUTIONS

Electrostatic Discharge

B HinT

Electronic devices such as a digital dictation machine can suffer mal-
functions due to electrical discharge. If you are electrically charged
when you touch a dictation machine which is already switched on, the
device sometimes switches off to prevent further damage. If a recording
was in process, check that the current dictation is complete. You may
have to re-record a few seconds of text.

Safety Precautions for Batteries / Rechargeable Batteries

I HINT

Batteries and rechargeable batteries are accessories and not
included in delivery of each model of dictation machines.

A WARNING

Do not dispose of the batteries in fire, put in backwards, mix
with other battery types, carry loose in your pocket or purse,
disassemble or modify. Do not short-circuit the batteries. The
batteries may explode or leak and cause burn injury.

Never use any battery with a torn or cracked outer cover.
Keep batteries out of the reach of children.



GENERAL PRECAUTIONS

Safety Precautions for Power Supply Units

B HiNT

Grundig Business Systems power supply units may only be
used for operating Grundig Business Systems office equipment.

The only way to disconnect the power supply unit from the
mains supply is to unplug it.

A power supply unit is an accessory and not included in deliv-
ery of each model of dictation machines.

A DANGER

Never plug in or unplug the power supply unit with wet hands.
This may cause electric shock or injury.

Never insert any metal or similar objects into the power supply unit.
Never open or modify the power supply unit or its plug and cable.

A WARNING

Only use the power supply unit with the mains voltage stated on its
type plate. Using it with other voltage levels may cause fire, explo-
sion, overheating, electric shock or injury.

Do not place any heavy objects on the power supply unit or cover it
up. Make sure it is always in a stable position, and do not use it in
positions where it may present an obstacle or hazard.

Only use the power supply unit with the Grundig Business Systems
power cord or adapters supplied (Euro, GB and USA versions). Never
use other power cords or adapters with different types of plug.

Keep the power supply unit out of the reach of children.

Always pull the mains plug, not the cable. Do not excessively bend
or kink the cable, and do not place any heavy objects on it. If the
housing or the wires are damaged or the power supply unit appears
not to work properly, you must not use the power supply unit. Pull the
plug out of the socket and consult your authorized dealer for repair
or replacement. In case the power supply unit got dropped, please
contact your authorized dealer to verify that the power supply unit is
fully operational and complies with the safety standards.

10



GENERAL PRECAUTIONS

A WARNING

Only use the power supply unit indoors and in dry environ-
ments. Make sure the power supply unit is protected from
moisture such as dripping or splashing water, as well as high
levels of air humidity.

Do not store or operate the power supply unit near heat
sources, in hot places or in direct sunlight. Ensure proper
ventilation.

Temperature range for use of power supply unit
Storage: -20°C to 70°C [/ -4°F to 158°F
Operating temperature:......... 0°C to 35°C / 32°F to 95°F

Do not store or operate the power supply unit at temperatures
outside these ranges.

Always unplug the power supply unit from the socket before
cleaning.

To avoid scratching or damaging the power supply unit, use a
soft, dry cloth to remove any dirt. Never clean the power sup-
ply unit with a damp cloth, as this may cause it to malfunction
or make it unsafe. Cleaning agents, alcohol, thinners, gasoline
or similar fluids for cleaning, must not be used as these may
damage the surface or labeling.

Temperature range for use of Digta 420:
Storage: -20°C to 70°C [/ -4°F to 158°F
Operating temperature:  -15°C to 35°C / 5°F to 95°F

11



NOTES

Your Digta 420 is a digital portable dictation machine. It is
designed to record and play-back spoken language.

The dictating machine can be used as a single workstation dic-
tation system together with the included software. It may also
be integrated into a network solution (local network with several
authors and typists). The dictating machine offers functions
such as inserting or deleting passages that allow you to easily
edit your dictations. Dictations can be transferred from your PC
onto a network.

C € The CE mark confirms that the device corresponds to the
relevant guidelines of the European Union.

Technical and visual features subject to change!

12



Notes

Scope of delivery

— Digta 420

— PC software
— USB cable
— Pouch

Accessories

For the latest accessories like Digta Card, Digta Station, Foot
control, plug-on microphone and earphone please visit the
Grundig Business Systems Website on the internet at

www.grundig-gbs.com.

The performance features described by Grundig Business
Systems only apply to genuine Grundig Business Systems
accessories.

Please make sure to choose only genuine accessories from
Grundig Business Systems. Product liability and warranty
service are provided only in this case. The use of non-Grundig
Business Systems accessories or those which are not recom-
mended and approved by Grundig Business Systems auto-
matically void any warranty claims towards Grundig Business
Systems.

13



USER CONTROLS

Earphone socket

Socket for external microphone
(output voltage max. 90 mV)

Microphone

LED indicator

Record: illuminated red
Record pause: blinking red
Insert: illuminated orange
Insert pause: jittering orange Display

PC transfer: jittering red . .
Charging of rechargeable batte- Slide switch for

Fast forward button

ries: blinking green oy - :gg’rdlng,
Selection buttons*% = play-bac_k
r < and rewind

Navigation buttons*%’
)

Lnew“-button

(new dictation) Digta Station 446:

Special extras

* labeled in the bottom
display line

Green indicator for
USB contact

Yellow indicator for
charging

14




REAR VIEW

Card slot for
MMC-/SD
cards

Slide switch for
recording, stop,
play-back

and rewind

L Battery com-
partment

On/Off switch
Keylock

15




DISPLAY

Display information

Menu Mode

_ Time Voice acti-  Recording/ o
Current function vationon  lay-back Card indicator
> Play-Back e mode Dictation with priority (PR)
® Recording in folder A ‘
11 Recording pause : Battery/USB/
_Y_Insert I I — power supply
> Play-Back End O 14:52 iRl . Remaining
PP Fast forward _ storage time
44Rewind -
Encrvotion / Dictat il _vV_ —— Microphone
ncryption / Dictation i
posit%g)n number o 3-5 sensitivity
Dictation number DICTOD 2 % 3 | s Dictation length
i Info number —— Status bar
> Index number O <

Current button functions,
for ex. modify dictation,

select dictation, menu Eas y Mode

To switch between
Menu MODE and
Easy MODE,

keep on pressing the
L,NEW" button after
having switched on
the DIGTA 420

until the initial display
appears on the dis-

play (hour glass and x <
progress bar).

DICTOD 2

For further information concerning the Easy MODE,
please see the Quick Reference Guide.

Note:
The displays of the further operation manual will figure in black type
against a clear background to be better recognized.



PREPARATION

Battery operation

The dictation machine can be used for approximately 9
hours when the alkaline manganese batteries are fully
charged.

* Open the battery compartment.

* Insert batteries (Micro type / AAA, 2 x 1,5 V). Make cer-
tain the polarity is correct.

» Close the battery compartment.
— Display for battery operation » === «.

B HiNT

A signal will be omitted when batteries are weak. The
battery symbol flashes on the upper right edge of the
display. You will still be able to dictate for a few minutes
until the dictation machine automatically switches off.

Rechargeable battery operation
To allow a smooth operation of the rechargeable battery*
you should always switch off your dictation machine after
you have finished dictations and connect it to the Digta
Station* to be recharged.
— Display when operating with rechargeable batteries:
PICLLIRS

Inserting rechargeable battery
With the Digta Station 446* you only may recharge the Akku-
Pack 466* rechargeable battery in the dictation machine.

» Switch off the dictation machine. Move the On/Off
switch upwards to »OFF/HOLD«.

* Open the compartment of the rechargeable battery.

* Insert the rechargeable battery. Make sure the polarity
and position are right (see figure).

P
2
i
g
2
:
|3
g

* Optional equipment 17



PREPARATION

0 IMPORTANT

The dictation machine’s operating system is “shut down”
(similar to a PC) when it is turned off. There must still be suf-
ficient power available for this purpose. If, after the dictation
machine has automatically turned off, you turn it back on
again without having plugged it into a power supply (e.g. via
USB cable to a PC) or without having inserted new recharge-
able batteries, your saved dictations may be permanently lost.

== The rechargeable battery is charged also when the dicta-
== tion machine is switched on. In this case, however, charg-
== ing will take a longer time.

Direct charging of the rechargeable battery 466

» Switch off the dictation machine by moving the On/Off
slide switch upwards to »OFF/HOLD«.

* Plug the power supply into the mains socket.

» Connect the USB plug of the power supply cable to the

»PC/USB« socket of the dictation machine.

— After a short time the display indicates that the bat-
teries are recharged and the green recording indica-
tor will be blinking.

— The flat rechargeable battery will be fully recharged
after about 4 hours. The charging indicator and the
recording indicator then go out.

e Pull the power supply from the socket and the power
supply cable's USB plug from the »PC/USB« socket.

l HINT

When the rechargeable battery is flat (total discharge), it may
take up to two hours until the load indicator appears on the
display. Please check if the dictation machine and the power
supply work accurately. To do so, take out the rechargeable
battery. Then connect the dictation machine with the mains
supply and switch on the dication machine.

18



PREPARATION

Charging the battery* — using the Digta Station 446*

e Connect your USB plug from the power supply cable to
the »DC IN 5V« jack of the Digta Station*.

* Plug the power supply plug to the wall outlet.
— The yellow indicator of the Digta Station* lights up.

» Switch off the dictation machine by moving the On/Off
slide switch upwards to the »OFF/HOLD« position.

» With the dictation machine switched off, plug it into the

Digta Station*

— Shortly aftterwards, the load indicator appears on the
Digta display and the LED-indicator blinks green. The
yellow indicator of the DIGTA Station flashes yellow
during the loading process.

— After approx. 4 hours the flat rechargeable battery is
recharged. The charging indicators and the recording
indicator disappear.

JUU

* Optional equipment 19



PREPARATION

Notes on rechargeable battery 466*

New rechargeable batteries do not reach full capacity until
they have been recharged several times. For this reason
the operating time for new rechargeable batteries in some
rare cases is less than 3 hours.

When the rechargeable battery is fully charged, you can
use the Digta up to 9 hours (DSS Standard Play).

The rechargeable batteries’ charge state is shown on the
dictation machine display:

— »==« Rechargeable battery charged;

— »c==« Rechargeable battery partly discharged,;
— »—=« Rechargeable battery weak;

— »—w« Rechargeable battery nearly flat.

The rechargeable battery must always be fully charged in
the dictation machine to make sure that the real charging
state is displayed.

Before the rechargeable battery is completely flat a short
warning beep will sound and the rechargeable battery
symbol »=« will flash on the display. There won't be
a warning signal in the recording mode. You will still be
able to dictate and play-back for a few minutes before the
dictation machine automatically switches off. However,
we recommend either starting the charging process after
the warning beep and the flashing rechargeable battery
symbol »==« or to use the power supply to operate the
dictation machine.

o IMPORANT

The dictation machine’s operating system is "shut down”
(as for a PC) when it is switched off. Sufficient power
must still be available for this purpose. If, after the dicta-
tion machine has automatically switched off, you switch it
back on again without plugging in the power supply or if
the rechargeable batteries have not been recharged, your
saved dictations may be permanently lost.

* Optional equipment 20



PREPARATION

Power supply operation via USB

You can connect your dictation machine to your PC via a
USB cable (included in delivery).

» Switch on your PC.

» Switch on your dictation machine and connect it to the
PC via the USB cable. A display for rechargeable bat-
tery operation appears on the upper right edge, or the
symbol »®=-« for power supply via PC flashes if the
batteries are fully charged.

» If automatic PC connection is switched on, the dictation
machine logs on at the PC via USB parallel operation.
Open the menu with the right selection button. Select
the symbol » T« for dictations in PC power supply
mode with the navigation buttons and confirm with the
right selection button » V «.

Now your dictation machine is supplied with power by the
PC (the battery in the device is not discharged) and you
can use it for recordings and play-back like under battery
operation.

Power supply operation

If the dictation machine has been switched on and a power
supply unit* is connected to the »PC/USB« socket, the
power supply unit will supply the dictation machine with
power. The rechargeable battery is charged.

— Display for power supply operation »:3#5-«.

Please use the Digta Station* for PC operation with power
supply.

* Optional equipment
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PREPARATION

Inserting and removing replaceable memory
cards

You can use memory cards (not included in delivery) instead
of the internal memory.
Use Digta Cards supplied as accessories by Grundig Business
Systems.
e Push the memory card into the slot with the side with
the diagonal corner facing the direction shown on the
back of the device.

I HiNTS

Do not insert the card with force. Slight pressure is suf-
ficient.

To remove the card press the memory card slightly
until the snapping mechanism unlocks.

Do not remove the cards when recording is running or
during data transfer from PC to PC. This can result in

data loss.

If a full memory card (e.g. with over 300 dictations) is
inserted into the dictation machine with factory default
settings (or with a reset dictation counter), it takes up
to 20 seconds to create a new dictation. This time is
required for the dictation machine to search for the first
free dictation number starting from dictation number 1.
This time also varies depending on the manufacturer
of the memory card.

If you use MultiMediaCards/SecureDigital Cards (MMC/
SD) with insufficient writing speed, »Card not sup-
ported!« will appear in the display.

Make sure that the electrical contacts on the under-
side of the memory card are not subjected to physical
stress. The cards are not affected by dirt or moisture,
but they may only be put into the dictation machine
when they are clean and dry.
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PREPARATION

New memory cards must be formatted before any writing
can be done.

@ wvPoRTANT
It is essential that the notes in the chapter “The menu
— Formatting” be observed.

Formatting replaceable memory cards

£E0

|

v

Memory cards — including those which have been prefor-
matted — must first be formatted with the dictation machine
prior to initial writing.

If an error message appears after a non-formatted memory
card is inserted, confirm this with the right selection button
»\/«.

The »Format, delete all?« display should also be acknowl-
edged with the right selection button » V «.

The memory card may not be formatted as a removable
disk using a PC formatting function.

New memory cards may only be formatted using the
“Formatting” menu function.

@ wvPoRTANT
It is essential that the notes in the chapter “The menu
- Formatting” be observed.

We recommend reformatting the memory card on a PC
once it has been overwritten several times. The memory
card is defragmented during formatting. Access to the next
dictations is then faster.

23



SWITCHING ON THE MACHINE

Switching on and off

Initial switching on

Time/Date

OO BM Sy

26.07. HITH

HH R
12:40

FEET]

L

Move the On/Off switch down to »ON«.

Select a language with the navigation buttons » €4 » «
and confirm with the right selection button »\/«_, for
example, » English«.

An authors list appears when more than 1 author
(a maximum of 20 authors is possible) is configured.
Please select your name and confirm with the right
selection button »V«.

The author's list is created by the administrator at the
PC and transferred to the dictation machine.

I HINT

If there are more than one author, the dictation list
only shows the dictations with the author's recogni-
tion selected and confirmed by the user when he/she
switched on the machine. This ensures that other dic-
tations are not accidentally edited or worse deleted.

We recommend you to adjust now time and date. To do this
select year, month, day, hours and minutes with the
navigation buttons » A ¥« and confirm each selection
with the right selection button »V .

End your adjustments with »V .

You can interrupt the time setting with the left selection
button »4. « without saving the adjustments. Each time
you switch on the device in the future, the date and
time display will appear again, until the time setting is
concluded with the right selection button.

Now the device is ready for operation.

24



SWITCHING ON THE MACHINE

Subsequent switching on

Move the On/Off switch downward to "On".

If an authors list appears please select your name and
confirm with the right selection button »V .

Switching off
* Move the On/Off switch upward to »OFF/HOLD«.

Key lock
The keylock prevents you from accidentally turning off
the machine while you are recording or playing back a
dictation.

.'f—“"‘{"ﬂ T
DICTOO0E B:H3
& HoLD

NAVIGATION

When making a recording or playing back a record-
ing, push the On/Off switch upward to »OFF/HOLD«.
The keys are now locked and the »BHOLD « symbol
appears in the display. If you wish to unlock the keys
again, push the On/Off switch back to »ON«. You can
stop your recording or play-back again.

If you press the On/Off button in a different function, the
device will turn off.

Navigation in the menus

You may select desired menu items or functions/set-
tings with the navigation buttons » €4» «.

You activate menu items and confirm functions or
parameters with the right selection button »

With the left selection button »®-« you interrupt functions
without saving any adjustments.

25



EAsy MobpE - MENU MODE

The Easy MobEe serves for making the pure dictation functional-
ity of the Digta 420 available for the author.

The menu functions are switched off in the Easy Mope. Instead
of this, a delete button and an insert button are permanently
available.

The advantages of the Easy MobDE are:

All important functions (dictating-, delete- and insert

w2 == functions) are available on the buttons.
- The display is more neatly designed because only the
dictation information is displayed.
M - Operating errors of rarley used functions (e.g. change
X <« »r v folder, delete the entire memory, restore counter, insert
info/index) are excluded.
- All device settings (e.g. microphone sensitivity, length
of display illumination) which have been set in the Menu
MobE remain after switching over to the EAsy MoDE.
B HINT

Grundig Business Systems recommends to perform all settings
in the Menu MobpE, to activate the desired workflow functions
and then switchover to the EAsy MoDE.

Switchover from EASY MODE - MENU MODE

The switchover from the EAsy Mobe to MeENU MODE is
=== achieved through switching on the Digta 420.

L]
©14:52 19h46
1n._v_ PR °
o=z 3-5
DICTOD12 316
[

= NN

To switchover between the Menus, press the , NEW*
button when switching on the Digta 420 till the initial
display view appears on the display (hour glass and
progress bar).

A detailed description how to operate with the Digta 420 in
the EAsy MoDE is available in the attached Quick Reference

Guide.

26



PIN / PUK

Entering the four digits PIN

PIN: = = [§] _

Your dictation machine comes with a PIN/PUK function.
The PIN (Personal Identification Number) is activated via
the supplied PC software. Afterwards you have to enter
your PIN each time when you switch on your dictation
machine. Die PIN (personal identification number) can
be activated by means of the supplied PC software in
the menu item ,configuration/extended...“ or contact our
service hotline under.

www.grundig-gbs.com
Support / Contact Info

Default settings are 0000. You may change your PIN via

the menu functions described in the chapter ,THE MENU

— Modifying the PIN".

e You may confirm your entry via the navigation
buttons or you move the slide switch to
» 44 REW« (smaller figures) and confirm the figures
with the button »PPFFWD«.

Each figure you entered in will appear as a star symbol
"#" to screen from view. Having entered the fourth fig-
ure you will access the main menu.

If the wrong PIN was entered three times you have to wait
for 30 seconds to try again. However, if in three trials the
wrong PIN was entered three times, the dictation machine
will be locked and only may be unlocked via entering the
right PUK.
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PIN / PUK

Entering the eight digits PUK

Device locked!

If the wrong PIN was entered several time the dictation
machine will be locked. You then will have to enter the eight
digits PUK (Personal Unblocking Key)

¢ You may confirm your entry via the navigation
buttons or you move the slide switch to
» 44 REW« (smaller figures) and confirm the figures
with the button »»PFFWD«.

If the wrong PUK was entered three times you have to
wait for 30 seconds to try again. Entries may be done as
often as you like. The PUK is generated from the device's
specific serial number and will be supplied to you or to your
system administrator when you buy the machine.

Having entered the PUK the PIN will be reset to 0000.

Saving dictations on removable memory cards

PUEK:
-4 = 'fr
EXT
Mo PIN
protection

7

Dictations on external, removable memory cards (Digta
Card) can not be protected through the PIN/PUK function.
The following display appears when changing to an exter-
nal memory card:

- EXT No PIN protection
* Confirm with the right selection button »V« that you

would like to work with an external memory card without
PIN protection.
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RECORDING

Saving dictations, selecting a folder

Dictations are stored on the internal memory of the dic-
tation machine if no external, replaceable memory card
(Digta Card) is in use.

If a memory card is inserted, all dictations are recorded on
this card. The internal memory is protected against access
during this. It is not possible to copy between the internal
memory and the memory card.

DICTO
ETn 1 — When using an external memory card, »M« appears in
the display.

There are six folders available for this purpose: one main

[T ] :
Gawe in folder | folder »[J« and five subfolders labeled A, B, C, D, and
(= E. This allows you to sort your dictations (for example to
(& ! (& separate private from business dictations).

L A4 » Selecting a folder
» Activate in MeNu MopE the menu with the right selec-
tion button »F=ke

« Select the Folder menu command » C_J« with the navi-
gation buttons » 4P « and confirm by pressing the right
selection button »V «.

* Now you can choose the folder of your choice with the
navigation buttons. Confirm with »V «.

 You exit the menu with the left selection button »4-«.

Your dictations will now be saved in this folder. When you
turn the machine back on, the last selected folder and last
edited dictation will be displayed.



RECORDING

Dictation
* Speak in a direction just over the dictation machine.

The figure illustrates the optimum position. The high
precision microphone also allows you to record conver-
sations from greater distances.

New dictation
* Move the slide switch to » ISTOP«.
* Press the »NEW« button.

— A new dictation with the next highest number availa-
ble is created, display: »DICT0008« for example.

— The time and date are saved together with each new
ETY L == dictation (displayed only on the PC).

4has

n — The red recording indicator starts blinking, the white
DICTOO0E  B:BE Disc symbol » @« appears in the display as well as
the Pause symbol » I«

Tt =Y.
* Move the slide switch to »@ RECx«.
YD SE — The recording indicator blinks, the Disc symbol » @ «
dll starts spinning in the display and the Pause symbol
mcToong 239 turns into a Recording symbol » @ «.

Pi i — The device is recording.




RECORDING

Recording pause
[F ™ @ % * Move the slide switch to » IlISTOP«.

= — The recording indicator blinks, the Disc symbol
DicTooos  B:35 »@ >« stops spinning in the display and the Pause
symbol » ll« appears again.
r ¥
End recording
«  Press the left button » £« The Disc symbol turns black
»6 «,
Fast forward or rewind during a recording also ends the
recording.
— Each time a recording is ended, the time and data are
saved along with it (displayed only on the PC).
Modifying the dictation
During play-back you can record over the previously
recorded text at the current position or append a recording
to the current dictation.
Pay attention to the remaining free memory space. In EAsy
MobE the free memory space is displayed firstly after the
capacity falls below a value of 60 minutes.
» Move the slide switch to »BSTOP«.
* Select the dictation of your choice with the navigation
buttons » 4P « (see ,Select dictation and listen to it").
« Move the slide switch to »»PLAY« (play-back).
[ ﬂ [
> *hat o During play-back push the slide switch to » ISTOP« at the

DICTO00S 348 desired dictation position..
[ —

e i 15
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[

Move the slide switch to »@ REC« and dictate the new
text. The red recording indicator lights up, the white
Disc symbol » @)« starts to spin in the display and the
Pause symbol turns into the recording symbol » @ «.

0 IMPORTANT

This will overwrite your old dictation starting at this
point.

At the end of the dictation move the slide switch to
» M STOP«.
— The red recording indicator starts blinking.

Press the left button » %« or move the slide switch to
»PPLAY«. The recording is turned off.

B HiNT

If you move the slide switch to »@ REC« immediate-
ly after selecting the dictation, your dictation will be
appended.
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RECORDING

Inserting a part of a dictation

During play-back you may insert a new recording at your
current dictation position.

TE
DICTO00E A:39
L =Y

Insert part

F'*i PR

L I
AU Ly ==
n_r dh23
DICTD0DE #:39
t

Pay attention to the remaining free memory space. In EAsy
MobE the free memory space is displayed firstly after the
capacity falls below a value of 60 minutes.

Move the slide switch to »lSTOP«.

Select the desired dictation with the navigation buttons
» 4P« (see ,Select dictation and listen to it").

Move the slide switch to »»PLAY«, to listen to the dic-
tation.

During play-back, move the slide switch to »BSTOP«,
once you have reached the dictation position at which
you wish to insert the text.

Press the left selection button »E'IE’«, to enter the

modify menu.
Select the Insert »=F=« function.

Select the "Insert Part" »F"1« function from the menu
and confirm with the selectlon button »\/« the LED
indicator starts blinking orange, the white Disc symbol
»@« and the Pause symbol »ll« appear in the dis-
play..

Move the slide switch to »@REC« and dictate the text
you want to be inserted.

Move the slide switch to »BISTOP« once you have fin-
ished inserting the text.

Press the left button »®-« or move the slide switch to
»PPLAY«. The recording is turned off.
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RECORDING

The info function and the index function

In MENU MoDE As an integral part of a dictation, you can record
information (»Pi« = Info) for your typist and mark them, or set
index marks (»?«= Index) for specific parts of the dictation.
Info »Pi« or Index »”« appears in the display and the number of
info or index (DSS: from 01 to 16. DSS Pro: from 01 to 32). You
will hear an audible signal during play-back. These messages
and indexes are transferred to the PC with the dictation.

Inserting an info

In the MENU MoDE, you can insert a new info at the current
dictation position during recording.

* Move the slide switch to » MISTOP«.
* Move the slide switch to »@ REC«.

Y G == — The recording indicator lightens up, the Disc symbol
s » @« starts to spin in the display and the Pause sym-
DICTO00S .30 pol turns.mto the recording symbol »'«.. The device
is recording now. The symbols for Info »Pi« and Index

Pi | »P« are displayed in the bar for the key functions.

« Press the selection button »i« to insert an info at the
current position.

— The next highest info number, for eg. »"i2«, appears
in the display.

» Speak the info text when the next higher info number
appears in the display, e.g. »Fi2«.
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Move the slide switch to »BSTOP« once you have fini-
shed inserting the text.

Press the left button »%®-« or move the slide switch to
»P PLAY«. The recording is turned off.

Inserting an index

In the MeENU MoDE, a new index can be inserted at the acti-
ve dictation position during recording.

Move the slide switch to » ISTOP«.

Move the slide switch to »@ REC«.

— The recording indicator lightens up, the Disc symbol
» @« starts to spin in the display and the Pause sym-
bol turns into the recording symbol » @ «. The device

is recording now. The symbols for Info »*i« and Index
»P« are displayed in the bar for the key functions.

Press the right selection button »F«.

— The next highest info number briefly appears in the
display, »" 2« for example.

Move the slide switch to »MlSTOP«.

Press the left button »®« or move the slide switch to
»PPLAY«. The recording is turned off.



RECORDING

Dictating using the foot control

Connect the foot control to the »« socket of the
Digta Station*.

Connect the power supply to the »DC IN 5V« socket or
via USB cable to the »PC/USB« socket of a PC to sup-
ply the Digta Station* and the foot control with electric
power.

Move the slide switch to » IlSTOP«.

With the dictation machine switched on, plug it into the
Digta Station*.

Note:

If the dictating machine is switched on or off in the
Digta Station* and the Digta Station* is connected via
USB cable to the PC, the dictation machine is switched
to USB parallel operation.

The pedals on the foot control are designed for hands-
free dictation.

Left pedal

— Rewind;

Middle pedal

— Press shortly to switch recording on or off;

— Hold down (approx. 1.5 seconds) for a new
dictation. The red recording indicator lights up,
a new dictation number, for eg. »DICT0003« is
displayed;

Right pedal

— Start/stop recording and play-back.

B HINT

Select the fast forward function pressing the button
»PP FFWD« on the dictation machine.

* Optional equipment
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PLAY-BACK

Select dictation and listen to it

DICTO00S GH Y
I L B

Move the slide switch to » ISTOP«.

Select the folder in which your dictation is located (see
~Saving dictations, selecting a folder").

Select the desired dictation with the navigation buttons
» 4P «. The selected dictation name appears in the display.
If a dictation was renamed on the PC, or if it originates
from another dictation machine, the dictation name is
displayed as text, possibly abbreviated.

Move the slide switch to »P»PLAY«.

— TheblackDisc symbol »& «startstospininthedisplay,
the play-back symbol »P « appears on the left in the
display and the status bar begins to move. Play-back
starts at the beginning of the dictation.

B HINT

If, after you have turned on the dictation machine,
no new dictation is selected, the last edited dictation
will be played back at the position it was before the
machine was turned off.

If you wish to interrupt the play-back, move the slide
switch to » lISTOP«.

— The black Disc symbol »& « will stop spinning in the
display. The status bar stops moving.
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PLAY-BACK

Setting the volume

Eml3 e -
- +hat
DICT 000 G

e A 10

During play-back, press the left navigation button to
lower the volume or the right button to increase the vol-
ume.

— The loudspeaker symbol in the display »@« turns
into the symbol for adjusting the volume »all .

Skip quickly to the start or end of a dictation

Eml3 e (T T

<
- that
DICT 0005 3:46

o B LT

Move the slide switch to »P PLAY«.

By tapping the left selection button you can alternative-
ly jump to the start and end of a dictation.

B HINT

If an info or index was inserted during dictation the
next info start, info end or index is jumped to. If you are
at the end of a dictation you will jump to the beginning
of this dictation.

Fast play-back

Rl o (T 1}
- Shic
DICTO00S B:83

el B +15

w3 N T 1]
4h2g

|

DcToong 348

e A gie 21,0

Press the right selection button » ->1,5x « during play-
back.

— The dictation will be played back with about 1.5 times
the normal speed.

To return to the normal play-back speed, press the right
selection button » ->1,0x « during fast play-back.
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PLAY-BACK

Fast forward and rewind

0

Move the slide switch to » 4 4REW« or press the button
»PPFFWD«.

— The status bar in the display quickly moves forward or
backward.

Inserting an info

In the Menu MobDE, you can insert a new info at the active
dictation position during play back.

Insert info

Lo i 121

|

A

Move the slide switch to »IlISTOP«.

Select the desired dictation with the navigation buttons
» 4P« (see ,Select dictation and listen to it")

Move the slide switch to » P PLAY«, to listen to the dic-
tation.

Move the slide switch to »BSTOP« during play-back,
when you have reached the dictation position where
you want to insert your info message.

Press the left selection button »E4F«, to enter the
modify menu.

Select with the navigation buttons » 4P« the menu
function » =¥« (insert recording).

Select the info function »Pi« from the shown display
to insert an info and confirm with the selection button
»\/«, the red recording indicator flashes, the white Disc
symbol » @ «and the Pause symbol »ll« appear in the
display.

Move the slide switch to »@REC« and speak the info
message to be inserted.
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PLAY-BACK
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Fiz 8:35

Insert index

- The next highest info number appears in the display,
»Pi2«, for example.

Move the slide switch to »BMSTOP« at the end of your
recording.

Press the left button »®« or move the slide switch to
»PPLAY«. The recording is turned off.

Inserting an index

In the MeEnu MoDE, a new index can be inserted at the acti-
ve dictation position during recording.

P’iE’_

Tt =

vd

Move the slide switch to »IMlISTOP«.

Select the desired dictation with the navigation buttons
» 4P« (see ,Select dictation and listen to it”).

Move the slide switch to » > PLAY, to listen to the desi-
red dictation.

Move the slide switch to »BSTOP«, during play-back
when you have reached the position where you want to
insert your index.

Press the left selection button »E]E'«, to enter the
modify menu.

Select with the navigation buttons » 4P« the menu
function » =¥« (insert recording).

Select the index function »”« from the shown display to
insert an index and confirm with the selection button

«, the red recording indicator flashes, the white Disc
symbol » @«and the Pause symbol »ll« appear in the
display.
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PLAY-BACK

- The next highest info number shortly appears in the
display, for e.g. »M2«.

Move the slide switch to »IMlISTOP«.

Press the left button »%®-« or move the slide switch to
»P PLAY«. The recording is turned off.

Search for info or index

HYED) e
P2 A:35
L =Y.
1Y Gl T
-

Fiz 3517
1Y Gl T
i

P2 3517

Move the slide switch to » 44 REW« or press the » PP
FFWD« button.

—At an index and at the beginning of every info mes-
sage, the "winding" briefly stops and you will hear one
signal. At the end of an info message you will hear two
signals.

— The message is shown in the display, e.g. »¥i2« or »”2«.

I HINT
It is easier to find short messages and indexes in the
play-back mode.
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PLAY-BACK

Transcription with foot control

¢ Connect the foot control* to the »« socket on the
Digta Station*.

« To connect the Digta Station* and the foot control to a
power supply, connect the mains adapter to the »DC IN
5V« socket, or use a USB cable to connect it to a com-
puter using the »PC/USB« socket.

«  Push the slide-switch to »ll STOP«.

» With the dictation machine switched on, plug it into the
Digta Station*.

I notE

If the automatic computer connection is activated, the
dictation machine will log on to the computer in USB
parallel mode. Call up the menu with the right selec-
tion button. With the navigation buttons, select the
» 0 « symbol for power supply operation and confirm by
pressing the right selection button » v«

* The pedals on the foot control are designed for hands-
free dictation in the default setting. For transcription
mode, you first have to activate »Play-back« in the
»Foot control« menu item. See section “Foot control” in
chapter “THE MENU".

Left pedal
— Reverse;

Middle pedal
— Fast forward;

Right pedal
— Start/stop play-back.

* Press the foot control.
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PLAY-BACK

I notE

In menu setting »Foot control play-backg, it is not pos-
sible to edit an existing dictation or create a new dic-
tation. On pressing the New or Record buttons, the
“Play-back only” message appears.

You can delete dictation as long as it has not been
locked.

Automatic backspace

Every time play-back begins, the current position is rewound
by the specified time, and play-back begins from there. This
means that the part of the dictation most recently listened
to is played back.

— Automatic backspace is available in the following
steps:
Off, 1, 2, 4, 6, 8, 10 seconds (see menu item »Auto
Backspack« in the »Settings« menu).

i noTE

Automatic backspace is only possible in conjunction
with the Digta Station and the foot control.

If the device is in the Digta Station, the »Modify« menu
will not appear in the display. It is not possible to delete
or add dictations.
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MODIFY MENU

Editing an existing dictation

In the modify menu, several functions are provided to work on
a stored dictation. The dictation machine must be switched on
in the Menu MODE,.

* Move the slide switch to »IlSTOP«.

« Select the desired dictation with the navigation buttons
» 4P« (see ,Select dictation and listen to it”).

« Press the left selection button »E4F«, to enter the
modify menu.

E I . « Select between the Delete »X«, Insert ».¥—«, Data list
| Ead Y- »E8«, Priority on »PR«, Postpone »ER.« or Lock »i«

t A4 o functions.
- According to your selection you will be guided to the

menu items described in the "Deleting a dictation" or
"Recording" chapters.

«  Press the left selection button » %« to close the menu.
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MODIFY MENU

Display or modify data set in the dictation.

In the modify menu, additional data e.g. patient- or client data
can be assigned to each individual dictation by means of the
data set-function. The data can be assigned to the respective
dictation by means of a scanner when patient-numbers or folder
numbers are administered through barcodes in order to avoid
mismatches. See chapter ,The Menu / Data list".

» Move the slide switch to » lISTOP«.

» Select the desired dictation by means of the navigation
button » €4» « (see ,select and listen to a dictation”).

Press the left selection button in the MENU MoDE »@ﬁ
«, to enter the modify menu.

» Select from the display the data set function »%«.

— A dictation which already includes data is highlighted
with the ,ID“ symbol. It is displayed on the right side
above the dictation time indicator.

e The symbols»% @ % « appear on the display.

»@« — Show or change data set of the dictation.

e Confirm with the right selection button
in order to view further data of the data set.

- Firstly the ID can be viewed by means of
the left navigation button, and the individual
data by means of the right navigation
button.

« Confirm the data set which shall be entered
in the active dictation by means of the right
selection button or press the »4.« button, if
you only like to read the data.
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MODIFY MENU

»@« — Allocation or indication of a data set of the cor-
responding barcode or RFID.

The functions are only available in combination

with DIGTA Scan 404* or DIGTA RFID 414*.

» Hold the scanner near a barcode or RFID-tag
and press the right selection button »y/«.

- The successful reading of the ID is indica
ted by a signal tone.

The corresponding data set will appear on
the display.

e Confirm it with the right selection button
in order to view additional data of the data
set.

- Firstly the ID can be viewed by means of
the left navigation button, and the
individual data by means of the right
navigation button.

» Confirm the data set which shall be entered in
the active dictation by means of the right
selection button or press the »4.« button,
if you only like to read the data.

»% « —Delete a data set of the dictation

« A prompt appears and you will be asked wheth-
er you really want to delete the entire dictation
é«. If so, confirm it by pressing the right selec-
tion button »V«. The data set is deleted. There
is no data set stored in the current dictation any-
more. The data set in the data list remains and

can be assigned to another dictation.

— An assigned data set in the dictation is marked with the
symbol »ID« and is displayed above of the time indica-
tor.

* Special extras 46



MODIFY MENU

Setting a priority to a dictation

Priovity on

~@e

You can add a priority to a dictation.

I HinNT

In the DSS standard, the priority levels ranging from 1 (high
priority) to 16 (no priority) are selectable. The dictation
machine can allocate for each assigned author an individu-
al maximum of author priority to a dictation. The presetted
priority for the author Dict is 15.

The dictation machine should be configurated with the
corresponding PC software. Transfer your author name
together with a maximum priority smaller than 16 to your
dictation machine. The installation of the dictation machine
software configuration within a network is carried out by a
system administrator.

» Move the slide switch to »BSTOP« during recording.

» Select the chosen dictation with the navigation buttons
» 4P« (see ,Select and listen to a dictation).

* Press the left selection button »EIE’«, to go to the
Modify menu.

» Select the »PR« priority function from the display.

— The dictation is marked with a »PR«, displayed above
the time data.

» If the selected dictation already has a priority you can
erase it with the »Priority off« menu item.
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Postpone a dictation

You can prevent the automatic PC transfer of a dictation (via
DSS mover) with the postponed function in the Modify menu
item. Postpone uncompleted dictations before transferring com-
pleted dictations to the transcription office by connecting the
dictation machine via USB.

Fosiponed on
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Move the slide switch to »IlSTOP«.

Select the chosen dictation with the navigation buttons
» 4P« (see ,Select and listen to a dictation).

Press the left selection button »EIE’«, to go to the
Modify menu.

Select the »E*.« function (postponed on) with the navi-
gation buttons » 4P « and confirm with the right selection
button »V «.

The dictation name is displayed inversely.

The dictation is postponed, that is not being transferred
by the DSS mover.

Press the left selection button »4_«, to exit the menu.
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Dictation lock

The dictation lock helps to avoid that your dictations are
unintendedly modified or deleted. It doesn't only work in the
dictation machine but it activates the write/erasure protection
in the dictation accompanying note. With such a lock the whole
Grundig Business Systems PC dictation system only allows to
modify or delete a dictation, if this attribute is deactivated on the
PC or in the dictation machine.

» Move the slide switch to » ISTOP«.

» Select the folder in which your dictation is located (see
“Saving a dictation, selecting a folder”).

» Select the desired dictation using the navigation but-
tons » 4P «. The selected dictation name appears in the
display.

— Press the left selection button »E'IE’« to change the
Lock menu.

1
G2, m i ¥ - Select the dictation lock symbol »g« on the right using
o e the navigation buttons » 4P «.
-1 |

t v
» Confirm with the right selection button »V .
E &M ﬂ (] — If the dictation is locked you only can select unlock
5"'E':'ﬂ':' the dictation »fa@ « in the Modify menue »El+F«.

[
DICToo0s  B:39
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DELETING A DICTATION

Deleting an entire dictation

Herein is the cancelling in the Menu Mope described. Please
read the contents item “Deleating of a dictation” provided in
the Quick Reference Guide when you prefer to operate in the
EAsY MobDE.

EEE o
Delete dictation
B Eh
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Move the slide switch to » lSTOP«.

Select the folder in which your dictation is located (see
~Saving dictations, selecting a folder").

Select the desired dictation with the navigation buttons
»<4P«. The selected dictation name appears in the
display.

Press the left selection button »EHE’«, to change the
menu.

Confirm the Deleting function »X« to change the menu
with the right selection button »V e

Confirm the »X « function in the submenu with the right
selection button » V « to delete the selected dictation.

Confirm the »0« query for final deletion of the com-
plete dictation with the right selection button »\/«. The
dictation is deleted now.

If you would not like to delete the dictation, press the
left selection button » -«
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DELETING A DICTATON

Deleting the contents of a folder

In MENu MobE Not only can you delete individual dictations
but also the contents of a selected folder or the contents
of all folders.

A
T

Delete dictation
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Move the slide switch to » lISTOP«.

Select the main menu featuring the »=k symbol with
the right selection button.

Select the menu command »X« and confirm with the
right selection button »V «

The following symbols will appear in the display:

X - Delete selected dictation
X _ Delete selected folder

% _ Delete all folders

B HINT

If there are more than one author the symbols for
»Delete folder X'« and »All folders X« are not dis-
played. This ensures that dictations from another user are
not accidentally deleted.

Using the navigation buttons » €4 « select the icon for
the desired function and confirm by pressing the right
selection button »V «.

Confirm the »0« query for final deletion of the selec-
ted folder or all folders with the right selection button »
V «. The dictation is deleted now.

If you would not like to delete the dictation, press the
left selection button » %«
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DELETING A DICTATON

Deleting a part of a dictation
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Move the slide switch to » MISTOP« in the Menu MoDE.

Select the folder in which your dictation is located (see
“Saving a dictation, selecting a folder”).

Select the desired dictation using the navigation but-
tons » 4P «. The selected dictation name appears in the
display.

Move the slide switch to »P»PLAY« and to »MSTOP«
at the desired position in the dictation.

Press the left selection button »EIE’« to change the
menu.

Confirm the Deleting function »X« to change the menu
with the right selection button » V «.

Select the »_% « symbol in the submenu that now
appears and confirm by pressing »V .

Press the right selection button » P« to set the starting
position of the text to be deleted.

Using the slide switch, now search for the desired end
position of the text to be deleted.

Press the right selection button »P2« to set the end
position.

Press the right selection button » X « once again. The
selected part is deleted.

If you would not like to delete the part of the dictation,
press the left selection button » e
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THE MENU

Functions in the menu at a glance

xXBE

| SR I Y

* Press the right selection button »[=)« in the MENU MODE.

With the navigation buttons » 4» « you may select the
following functions and confirm them with »\/«

X — Delete; delete the current dictation, delete
all dictations in the current folder, delete all
dictations in all folders.

(I Selecting a folder (main folder and subfolder A, B,
C,D or E); for sorting new dictations and playing back
the dictations stored in the various folders.

ik

Data list-functions (are only available when the
data list was monitored or read in):

— Delete data list.
— Search for the data set by means of the scanner.
— Select a data set for a new dictation.

i EHER

— "Enable” data list in the workflow.

— Scanner-functions (only with DIGTA Scan 404* or
DIGTA RFID 414* available):

— Delete barcode/RFID.
— Scan barcode/RFID

— Search for the corresponding dictation of the
barcode/RFID.

— Enable scanner in workflow.

I8 EF)

= e

— Programming of the barcode-reader.

o

— Activate workflow functions (group, typist, dictation type,
priority, No./reference).

o — Switch functions:
@l — Set microphone sensitivity.

* Special extras
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— Voice activation (if enabled the dictation will be
automatically suspended if it is interrupted).
USB connection or only if manually selected.

— Preselect time when the energy saving, non-ope-
rative state shall be activated automatically. The
Digta will completely switch off 30 minutes later.

— Switch off audio signals.

— Switch display lighting on/dimmed.

— PC file transfer occurs either automatically via
— Switch off the speakers for play-back with ear-
phones in the Digta Station*.

— Changing the fast forward / rewind speed.

— Selects the functions of the foot control for
recording or play-back

— Changing the automatic backspace time.

— Setan index or 1.5 fold play-back speed with
the right selection button during play-back.

— Dictation position number indicator on/off.
— Time indicator on/off.

— Modify date and time format

— Display of ID-contents (barcode) on/off.

Settings; here is where you can change the basic
settings of the device:

— Information about serial number and firmware
version.

— Selection of the DSS type (DSS Standard "SP",
DSS Pro "QP") and encryption.
— Change date/time.
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5 — Reset dictation counter to "1".

PIN - Change individual identifictation number (PIN).

o
o.

— Reformat the data storage device. All dictations and other
files will be erased.

— Restore the default settings. All dictations, files, and all
settings will be erased.

0 IMPORTANT ! Data loss!
F‘B,: — Selection of the display language.

Functions available if the device is connected to a PC:

—USB parallel operation

"= The PC identifies the device as USB removable medium

= for dictation/file transfers.Additional USB audio and

dl USB HID: Activate the dictation machine as PC micro-
phone (without recording), when connected to a PC, for

example for direct dictation to the Grundig PC software
or to a voice recognition system.

e

— USB powered
The PC doesn'’t recognize the device; for record/play-
back like under rechargeable battery operation.

I HINT

If there are more than one author the menu item ,Factory setting* is not
available and the ,Formatting“ menu point is only visible if there are no
dictations (.DSS/.DS2) on the Digta.
To be able to format the Digta ensuring that no other dictations are acci-
dentally deleted, the user has to transfer all dictations to the PC first.
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Data list

This function enables you to record dictations related to an
ID (e.g. patient- or client number, also scanned
barcode or RFID recognition) with text information.

This information is created on your PC in the CSV format
(comma separated values), e.g. via Excel, stored under the
name ,ids.csv* and transferred to the Digta’s panel direc-
tory (see »Carrying out a firmware update«).

This information is scanned in after switching on the dicta-
tion machine again.

Example:

LD, »Name, ,First name", ,Date of birth”
,1443%, | ,MARK O’Public”, ,Peter‘, ,24.05.2000“.
3221, ,,MARK O’Public”, ,Helen“, ,01.01.1911"

The values are separated through commas/semicolons.
The first line contains the field names. These values may
be inside of quotation marks.

Search for the data set by means of the scanner:

If an identification number (ID) exists as barcode or RFID

tag (e.g. on an x-ray photograph or on an envelope folder),

your dictation machine is able to display the corresponding

text information and to allocate them to a dictation (with

Digta Scan 404* or Digta RFID 414%*).

» Select with the navigation buttons » €4» « the menu item
,data list* »&8« and confirm it with the right selection but-

ton »\/« .
-~ - - " . . . )
» Select with the navigation button » €4 » « the menu item
Jr— »Scan ID« and hold the scanner near a barcode or
ScanliD RFID-tag and press the right selection button »V .
=§§ E oo -The successful reading of the ID is indicated by a sig-
158 [0 552 nal tone. The corresponding data set will appear on the
display.

* Special extras 96
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—»[No found]« is displayed in case that the scanned
barcode or RFID-tag is not allocated to a dictation.

Confirm with the right selection button »\/«, in order to
view additional data of the data set.

— Firstly the ID can be viewed by means of the left navi-
gation button and the individual data by means of the
right navigation button.

In case that you like to start a new dictation in which
this data set shall be entered, confirm it with the right
selection button ,NEW".

Move the slide switch to »@ REC«.

— The dictation machine will start the recording.

Or press the »V « button, if you only like to read the
data.

Select data set for a new dictation:

Select with the navigation buttons » €4» « the menu
item ,data list* »®E« and confirm it with the right selec-
tion button » V' «.

Select with the navigation buttons » «4»« the menu
item »Select« and confirm it with the right selection but-
ton »

Select with the navigation buttons » €4 » « the desired

data set and confirm it with the right selection button in

order to view additional data of the data set.

— Firstly the ID can be viewed by means of the left navi-
gation button and the individual data by means of the
right navigation button.

In case that you like to start a new dictation in which
this data set shall be entered, confirm it with the right
selection button ,NEW".

Move the slide switch to »@ REC«.

— The dictation machine will start the recording.

Or press the »V « button, if you only like to read the
data.
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Deletion of the data list:

B HINT

This function enables the deletion of the entire data list.
The data list functions are unavailable afterwards until a
new data list has been read in.

» Select with the navigation buttons » 4» « the menu
item ,data list" »Bi« and confirm it with the right selec-
tion button » V'« .

» Select with the navigation buttons » €4» « the menu
item »Delete« and confirm it with the right selection but-
ton »\/«,

v ° Ci)/nfirm the cancellation with the right selection button
»W «.
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Group

The »Group« function is used to assign your dictation to a
specific group or department.

* Go to Workflow lists »« and confirm with the right
selection button »V «.

* Select the »Group fifl menu item and confirm with the
»V « button.

» Select »On request fize, »No entry K« or »Automa-
tic M.

—»On request«: a group may be selected for each new
dictation;

—»No entry«: no group selected;

—»Automatic«: each new dictation has the same

Mo entry group.
el o & «  Confirm your selection with the »V « button.
LERL y
t R I HiNT

For a new dictation, or if you have selected the
»Automatic« function, you select your group from the

SroLn ] list. »No entry :ﬁ(« appears in the display if no groups
Group A were defined.
K m |ﬁ1r2=1 Confirm with the »V « button.
£ 4 » You may create individual preallocations for the list

using the PC software.
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Typist

TypiSt
Mo entry

L

m
*

vd

TSt

Mustermann

x [ -

LT L]

t =

The »Typist« function is used to select the transcriber who
will receive your dictation.

Go to Workflow lists »« and confirm with the right
selection button »V/«.

Select the »Typist M« menu item and confirm with the
« button.

Select »On request <, »No entry X« or »Automa-
tic M.

—»0n request«: A selection of transcribers will be
offered for each new dictation;

—»No entry«, no typist is chosen for the dictation;

—»Automatic«, each new dictation will be assigned to
the same transcriber.

Confirm your choice with the »V « button.

B HiNT

If you have a new dictation, or if you have selected
the »Automatic« function, you select your transcriber
from the list with the navigation buttons » 4P «. »No
entry X« appears in the display if no transcribers
were defined.

Confirm with the »V« button.
You may create individual preallocations for the list
using the PC software.

60



THE MENU

Dictation type
The »Dictation type« function is used to select the template
to be used for the dictation: for eg. fax, letter, or report.

* Go to Workflow lists »« and confirm with the right
selection button »V «.

» Select the »Dictation type D« menu item and confirm
with the »V « button.

* Select »On request «, »No entry M« or
»Automatic D«.

—»0n request«: A selection of formats will be offered
for each new dictation;

—»No entry«, no dictation type was chosen;

—»Automatic«, each new dictation shows the same
dictation type.

» Confirm your choice with the »V « button.

Mo entry

N B HiNT

For a new dictation, or if you have selected the
r L »Automatic« function, you select your dictation type
from the list with the navigation buttons » 4P «. ,No
entry” »h appears in the display if no dictation types

on type [ErT)
E-Kail were defined.
E’ B Confirm with the »V« button.
t 4 r You may create individual preallocations for the list

using the PC software.
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Priority
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With the function »Priority« you can determine if the new
dictation shall have priority because it urgently needs to be
typed before the other dictations.

The dictation is marked with »PR« and is displayed above
the time data.

B HiNT

In the DSS standard, the priority levels ranging from 1
(high priority) to 16 (no priority) are selectable. The dic-
tation machine can allocate for each assigned author an
individual maximum of author priority to a dictation. The
presetted priority for the author Dict is 15.

The dictation machine should be configurated with the
corresponding PC software. Transfer your author name
together with a maximum priority smaller than 16 to your
dictation machine. The installation of the dictation machine
software configuration within a network is carried out by a
system administrator.

e Go in the menu item workflow lists »« and confirm it
with the right selection button »V «.

» Select the menu item »Priority PR« and confirm it with
the button »V«.

» Select the priority settings by means of the navigation
button » €4» «.

ER— You may select between »no priority« and »with
priority« (level of an author's maximum priority) when
starting a new dictation.

Bg — Priority is not set when starting a new dictation.

«  Confirm it with »V «.
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No./Reference
The function »No./Reference« enables to input up to 16
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characters for this dictation — for example: folder num-
ber or patient number.

Go in the menu item workflow lists »« and confirm it
with the right selection button »V <.

Select the menu item »No./Reference » % « and con-
firm it with the button »V/«.

Select by means of the navigation button » 4P«
between »Automatic«, »On request« or »No entry«.

><Y\ — Automatic - each new dictation has the same
number or reference.

g— On request - the input of characters is put at
disposal for each new dictation.
F“_iﬂ— No entry - no number/reference has to be

selected for each new dictation.

When having chosen the function »On request« in a

new dictation, an empty display field will be shown for the
first time. When having entered a no./reference in the pre-
vious dictation, then this will be displayed also in the next
dictation. You can either accept it or delete it. Press the
navigation button » 4 » « in order to access the selective
list including the numbers and references.

Select by means of the navigation button » 4» « the
character. For acceptance, confirm it with the »_ _ V¥«
button.

B HiNT

In order to improve the reference selection list, the
system administrator may restrict the set of characters,
for example, if only numbers (patient numbers) are
accepted.
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* Repeat the entry for additional characters and, at the
end, confirm them with the »V« button.

e Confirm the entry with the »V « button or delete the
entry with the »X « button.

B HiNT

Numerics and special characters are available in the
second subdirectory of the reference set. For this purpose,
select by means of the navigation button » € » « the sign
»7 and confirm it with the »V « button. Select the same
sign »~k again to return to the last directory.

Select by means of the navigation button » €4 » « the sign
»%&l«, and confirm it with the » ¥V« button in order to
delete the last adopted character.
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Microphone sensitivity

You can select one of three levels of noise sensitivity for
your microphone.

=== * Go tothe menu item »Zal« and confirm with »V <.
Mic. Sensitivity

» Set the sensitivity of your microphone using the naviga-

okt E &M tion buttons » 4P «.

@ﬂ — Recommended for loud speakers. Prevents
overmodulation for dictations which are pro-
cessed by a voice recognition system.

@] — Normal setting for dictations.

@j — Conferencing. The machine can still record
accurately if it is positioned on a conference
table.

e Confirm with »\/ «.
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Voice activation
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If the function “Voice Activation” is active, the recording
will be interrupted if there is a pause in speaking in a quiet
environment. If the dictation machine does not turn off,
select a lower microphone sensitivity, for example for nor-
mal dictation or persons who speak loudly. As soon as the
speaker starts to speak again, the recording will continue.

e Go to the menu command »@!« and confirm with

»v«,

* Select »@!« (Voice Activation ON) or »M« (Voice Acti-
vation OFF).

«  Confirm with »V «.
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Automatic power off
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With the ,SLEEP MODE*" »@« function you determine
whether the device turns to a power-saving "sleep mode"
after some minutes or has to be switched off manually. The
device will be immediately switched on again as soon as
any key is pressed.

Move the On/Off switch to the »OFF/HOLD« position to
switch off the device completely. If you don't switch off
the machine manually it will switch off itself after about 30
minutes. Move the On/Off switch to »OFF/HOLD« and then
again to »ON« to switch on the device again.

* Select the menu item >>E\« and confirm with the right
selection button »V «.

« Using the navigation buttons » 4P« select the time
(,,Never“»ﬁ«, i «, i« OF »am «) to determine after
which time the device shall turn to the power saving
"sleep mode".

» Confirm with the right selection button »V <.

- In the sleep mode date and time is displayed like a
screen saver.
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Audio signals
The »Audible signals« function »i« enables you to turn
the acknowledgement and signal tones on and off.

« Select the menu item »i« and confirm with the right
selection button »V «.

+ Use the navigation buttons » 4P « to switch on all sig-
nals »&v« or only the warning signals »ﬁ‘]!«, or to switch

@ @ f;} off all signals »# . Confirm your choice with the right

v SRR | selection button »V «.
+ -1 = J

Signals

EENEIET === I H”.\IT X . .
All signals on If all signals are switched off you will not hear a signal
@ Eﬂl ﬁ when the memory is full or the rechargeable battery
* is flat.
+ e If you dictate without looking at the display, the device
may switch off with no signal tone, and you may not
notice.

If only the warning signals are switched on there won't
be any special blips, neither the readiness signal after
switching on nor the info and index signals.
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Dimmed
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This function serves for setting the time period of the dis-
play illumination brightness. The illumination is dimmed
after a few seconds to save battery.

« Goin the menu item ,Dimmed® »« and confirm it with
the button»\/«.

. Select now »always dimmed“ »%«, the number of
seconds you prefer to have a bright illumination or
»never dimmed* »*'« (always bright).

«  Confirm it with »V «.
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USB connection automatic / manual
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You can choose whether the dictation machine automati-
cally switches to USB parallel operation when connected
to a PC's USB connection or whether you want to activate
this function manually.

. Select the menu item »M« and confirm with the right
selection button »V «.

e Select »MAN. CONNECT« (manual USB/parallel oper-
ation) and confirm with the right selection button »V .

- The dictation machine remains in dictation mode
when USB connected. The PC supplies it with
power.

* Select »AUTO CONNECT« (automatic USB parallel
o;:/eration) and confirm with the right selection button
»W «.

- If the dictation machine is already switched on when
connected to USB the USB parallel operation e«
sets up automatically. The computer identifies the
device as removable medium. USB audio and USB
HID are activated. Now you can both transfer data
between PC and dictation machine, and use the dic-
tation machine as USB microphone.
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Speaker

You may switch off the loudspeaker of your dictation
machine with this function if you want to listen to your dic-
tations via headphones connected to the Digta Station*.

EUTTTEEN === - Seclect the menu item » i« and confirm with the right
fSoskor selection button »V «.
i <7 +  Select » i« (Speakers ON) or »¥« (Speakers OFF).

+ = = . °* Confirm with the right selection button »\/«.

[zpeaker LTl I HINT

Speaker on The speaker of the dictation machine automatically
switches off if an earphone with earphone connection
is plugged on.

* Optional equipment
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Fast forward / rewind

This function allows you to set the speed for fast forward
and rewind. You can select very slow, slow and fast.

* Go to menu item »FFWD/Rewind »«« and confirm with

»\/«_
o] ) .
FFWD i Rewind « Use the navigation buttons » 4P « to select the speed.
The selected function turns black.
st @ L= My
3% — Very slow FFWD/Rewind speed (approx. 1/3 of
T 4 = the fast setting)
",
it — Slow FFWD/Rewind speed (approx. 2/3 of the
] ;
] fast setting)
My .
e e wen — Fast FFWD/Rewind
_ .« confirmwith »V«
= - -
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Foot control

The »Foot control« function allows you to select whether
the foot control is used for transcription mode or hands-free

dictation.
e = ° Select the menu item »é« and confirm with the right
[REETE IR selection button »V «.
.

<« s « Use the navigation buttons » 4P« to select "Record"
»é_:f« or "Play-back" >>,§_:f<< and confirm with the right
I B ol selection button »V «..

Foot control assignment during recording

The pedals on the foot control are designed for hands-
free dictation.

Left pedal

— Rewind;

Middle pedal

— Press briefly to switch recording on or off (same
function as slide switch »@ REC« on the dictation
machine);

— Hold down (approx. 1.5 seconds) for a new dicta-
tion. The red recording indicator lights up and a
new dictation name, e.g. »DICT0002« displayed
(same function as the »new« button on the dicta-
tion machine);

Right pedal

— Start/stop recording and play-back (same function
as the slide switch on the dictation machine).

I HINT
Select the fast forward function using the button on the
dictation machine.

Automatic backspace settings only apply in transcrip-
tion mode. In hands-free dictation mode, the right pedal
does not perform automatic backspaces.
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Foot control assignment during play-back
The pedals on the foot control are designed for tran-
scription operation.
Left pedal
— Rewind;
Middle pedal
— Fast forward;
Right pedal
— Start/stop play-back.




MENU

Automatic backspace
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Here you can set the length of automatic backspace to
between 0 and 10 seconds. Every time play-back begins,
the current position is rewound by the specified time, and
play-back begins from there.

I HINT

The »Auto Backspace» menu item is only visible if the
machine is in the Digta Station*. The automatic back-
space function is only available when the foot control
is set to play-back. In hands-free dictation mode (foot
control set to record), the right pedal does not perform
automatic backspace.

. 44 .
« Go to menu item »Auto Backspace P« and confirm
with »V«.

« Use the navigation buttons » 4P « to select the duration
of the automatic backspace. The selected function turns
black.

144
ms" — Automatic backspace off. Normal setting for

play-back.
144

25 — 2,4, 6,8, 10 seconds. Duration of play-back
from the most recent dictation position.

«  Confirm with »V «.

* Optional equipment
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Setting an index during play-back
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You may choose whether the right selection button change
the speed or sets an index during play-back.

« Select the menu item »P« "Index in play" and confirm
with the right selection button »W .

«  Select the Index function »« or Change Speed function
1,0/1,5»=1,5« and confirm with the right selection but-
ton »\/«.
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Dictation position number
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The dictation position number indicates where in the cur-
rent folder the selected dictation is located. You are addi-
tionally shown the total number of dictations in the folder.
This function allows you to switch off the position indicator
to improve overview on the display during recording or
playback. To activate/deactivate the indicator, proceed as
follows:

¢ Select the menu item >>E « and confirm with the right
selection button »V «.

* Select »E‘: « (Dict.No. on) or »H« (Dict.No. off).
» Confirm with the right selection button »\/«.
BT

The dictation position number is not displayed in the EAsy
MoDE.
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Time indicator
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This function allows you to switch off the time indicator
to improve overview on the display during recording or
playback. To activate/deactivate the indicator, proceed as
follows:

¢ Select the menu item »@« and confirm with the right
selection button »V «.

» Select »@« (Time on) or »@« (Time off).

» Confirm with the right selection button »\/«.

B HinT
The time is not displayed in the EAsy Mobpe
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Date format
This function serves for setting a date format.
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Go in the menu item “date format* »335:5129' « and confirm it
with the button »V «.

Select by means of the navigation button » 4P«
between the following formats:

312,

15§ — European date format with 24-h display.
3&:51% — European date format with 12-h display.
%% — American date format with 24-h display.
12131

oiss —American date format with 12-h display.

Confirm the selected date format with the right selec-
tion button »V «.
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Display ID
With this function you can set the ID display format.
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Go to the menu item “Display ID” »« and confirm it
with »V «.

Select by means of the navigation button » 4P«
between the 2 display possibilities:

— Display as symbol "ID"

—Alphanumeric display of ID based on the dictation
name, for example, barcode in numerics.

Confirm the selected display format with the right selec-
tion button »\/«.
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Version
Using the »Version« function, the version (firmware) of the

S
Yersion

"o |
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Yersion

G06007 00071637

U1.H1B18H
v

m==] Mmachine’s software is displayed.

Go to the »{@« menu item and confirm with »V/«.

— The serial number of your dictation machine and the
version number of the firmware (software) appear in
the display.

B HINT

For information on new software versions call the
»Configuration => Update Server« function in the PC
software or visit us on our Website:

www.grundig-gbs.com.
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DSS Pro
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This function makes for the quality and storage capacity
of your dictations. DSSPro allows to set the quality and
encryption of dictations separately.

Quality Play (QP): 10 minutes recording require 2 MB,
especially suitable for voice recognition. File ending
».DS2«.

Standard Play (SP): 10 minutes recording require 1 MB,
saving memory for listening and typing dictations in the
typing department. File ending ».DSS«.

« Select the DSS standard »ksSl« menu point and confirm
with »V «

e Select between DSS »« and DSS Pro »« and con-
firm with »V «

— More setting options are only available (eg quality,
encryption) if you select DSS Pro. DSS-Pro dictations
are not displayed in the DSS mode.

* Select between quality »_« and encryption then Pk
and confirm with »

— These settings affect the recording quality of the dicta-
tion.

Select between Quality Play »[8« and Standard Play
»[BF« and confirm with »V «.

e In the menu of the dictation encryption you have
the same menu items as for the workflow lists.
Select between »no entry B« »on request B«
and »automatically « and confirm with »V/«.
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Time, date

The time and date a dictation is recorded are indicated for
each dictation (PC display only).

N ===
Time/Date

B &
FRO| EERIY 000

t =

v

EEINFER (===
Time/Date

OO BM Sy

26.07. HITH

HH R
12:40

ey

r ¥

Go to the menu command »@ « and confirm with
»W «.

You can now enter or change the year, month, day,
hours and minutes successively using the navigation
buttons » ¥ A «. The current function is shown on white
background.

Confirm each of your settings with »V «, The setting is
saved, and the next point is activated.

End your settings with »V «.

To chan@e your settings, go back to the menu com-
mand »
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Dictation counter

Reset counter

1NgJs

Reset counter

L
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Using the »Dictation counter« function, you can reset the
dictation counter. The dictation counter is able to count till
9999. You should not reset the counter too often to avoid
conflicts with dictations having the same name and being
stored on the PC.

Go to the »E3« menu item and confirm with »V «.
The »F3« and »@« symbols appear in the display.
e Confirm with »\/«.

— The next new dictation then has the lowest free
number (for eg.: »DICT0005«).
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Modifying the PIN

[zettings _ foer|
Change PIN
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The personal identification number (PIN) protects the
dictation machine against unauthorized use. The factory
settings are 0000. Do only enter a sequence of digits
known to yourself. You have to enter the PIN each time you
switch on the dictation machine as well as each time you
reactivate it from the "Sleep mode".

» Select the »PIN« menu item and confirm with the right
selection button »V «.

« Enter the old PIN via the navigation buttons » 4P«
(confirm the digits with the right selection button » ¥V «)

— Each entered PIN will be overwritten through a "s"
symbol for protection reasons.

Enter the new PIN via the navigation buttons with the
right selection button »\/«) and repeat entering the
new PIN for security reasons.
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Formatting

=etfings o o
Formatting
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With the »Formatting« function you reformat the internal
memory of your dictation machine or a replaceable, exter-
nal memory card.

B HINT

If a list of several authors is installed this function is only
available if there are no dictations in the memory. This
ensures that dictations from another user are not acci-
dentally deleted.

@ VPORTANT ! Data loss!
This function will delete all files and dictations on your
dictation machine.

¢ Select the Format »T« menu item in the settings menu
and confirm with the right selection button »V .

o IMPORTANT

Make sure an external memory card is plugged in if
you do not want to delete the internal memory.

. Confirm the complete formatting »% &%« of the memory
or the memory card with the right selection button »V «

— An egg-timer appears during the formatting process;
the progress is illustrated by means of a status bar.

Directories and files with administrative data are crea-
ted on the internal memory or the external memory card
as well. For this reason not the entire memory capacity
is available for recording dictations.

o IMPORTANT

The internal memory and the external memory card may
not be formatted as a removable disk with a PC format-
ting function.
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Default settings

Using the »Factory setting« function, you restore the fac-
tory settings of the machine.

EEEFE ===
Factory setting -
T o 1| D HINT
Be I If a list of several authors is installed this function is only availa-

ble if there are no dictations in the memory. This ensures that
L a4 e o .
dictations from another user are not accidentally deleted.

==
Reset, delete all 0 IMPORTANT ! Data loss!

'ﬁ"l}h
This function will delete all data and settings on your dic-
iy
tation machine!
r ¥

« Gotothe »¢d « menu item (see chapter ,Navigation in
the menus") and confirm with »\/«.

+ The symbols »&2] « and »@« appear in the display.
* Confirm with »\/ «.

Your device will be reset to the following settings:

Folder — main folder;

Microphone sensitivity — Dictation (normal setting for
dictations);

Voice Activation — off;

Switch off automatically — after 5 minutes;

Audio signals — all audio signals on;

Dimmed — 15 seconds;

Time, date — 01.01.2009, 00:00;

Workflow lists — Typist, dictation type, group,
No./reference automatic, priority off;

USB connection — automatic;

Speaker—on;

FFWD / rewind — Fast;

Foot control — Recording;

Auto backspace — Automatic backspace off;

Index in play-back — off, right selection button for
speed change;

Dictation position number — on;
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Time indicator —on;

Date format — European, 24 hours;

Display of ID — ID-symbol;

Dictation counter — 1;

PIN — retained, not reset to 0000;

DSS/DSS Pro — DSS

Language — Englisch

All dictations will be deleted; Preallocation for the dicta-
tion accompanying note will be reset to »No entry«. The
author's name will be set to »DICT«.

Language
EEi-Emmmmm === 1 his function makes for the language of the menu display.

Language
« Select the »"« language menu item and confirm with

1
m i @ the right selection button »V/«.

L o » + . Select the desired language with the navigation but-
tons » 4P« and confirm with the right selection button

Canguage —foro
Englizh W

1
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OPERATION WITH DIGTA STATION

Digta Station*
The Digta Station* serves as communication interface
between the Digta and the PC, as charging unit and as
Digta stand. A foot control and an earphone may be con-
nected to the Digta Station* (not included in delivery).

USB interface
You can exchange data via the USB interface (green indi-
cator at the Digta Station*) of the PC.

Additionally you may use a USB audio / HID function to
dictate into the Grundig Business Systems PC software or
in voice recognition systems.

Foot control*
It's possible to plug in a foot control for hands-free dicta-
tions.

Charging unit*, power supply
When plugging the power supply (yellow indicator at the
Digta Station*) the rechargeable battery* is charged in the
Digta. The foot control* and the earphone* are supplied by
the power supply and may be used without connecting a
PC via USB.

* Optional equipment
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COMMUNICATION WITH THE PC

The Grundig Business Systems PC software

The Grundig Business Systems PC software allows you to
transfer your dictations to your PC. You immediately have an
overview of all your work and can also listen to the dictations
on your notebook. Send your dictations to a speech recognition
system — or send voice mail through a connected mail system.

If your office organization uses the digital dictation system from
Grundig Business Systems the Digta and the PC software
will make you a mobile member on the dictation network. You
have all author and transcriber addresses at your fingertips for
sending dictations. Your typing pool is perfectly organized with
dictations identified by dictation type, deadline, and priority. If
all of your dictations have the same priority, simply connect the
USB cable to your Digta. All dictations will be sent to the preset
transcriber and your Digta will then be immediately available for
further dictations.

System requirements
Pentium processor (500 MHz or higher)

Operating systems:
WIN 2000 SP4 Rollupl
WIN XP SP2

WIN Vista

WIN 7

USB 1.1 or 2.0 serial interface
For e-mail connection: MAPI-compatible mail system
(for eg. Microsoft Outlook)
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COMMUNICATION WITH THE PC

Connecting and separating the dictation machine
and the PC

¢ Use the USB cable to connect the switched off dictation
machine to the USB interface at the PC via the »PC/
USB« port.
— The dictation machine begins to charge the rechar-
geable batteries*. The green LED is blinking!

* Move the On/Off switch to »ON« to switch on the dicta-
tion machine.
— Now you are prompted for the PIN.

0 IMPORTANT

Disconnect the USB interface via the task bar, as other-
wise the transfer may not be complete.

I HiNT
The Grundig Business Systems PC software can only be
connected to one dictation machine at a time. If you connect
a second dictation machine to the USB interface, the PC will
not detect it, i.e. Windows will only display one removable
disk drive.

USB parallel operation

dl

=

PC file transfer
¢ Connect the dictation machine to the PC via the USB
interface.

— If the dictation machine is already switched on the
USB parallel operation mode »#=« sets up automa-
tically. The computer identifies the device as remo-
vable medium and as USB audio/HID device.

Now you can transfer data between PC and dictation machine.

» Select USB parallel operation »« in the main menu if
"Auto connect" is switched off and confirm with the »V «
button (see chapter “USB connection automatic /

manual”). * Optional equipment
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PC microphone operation, USB Audio, USB HID
» Use the USB cable to connect the dictation machine to
the USB interface at the PC via the »PC/USB« socket.

*  Move the On/Off switch to »ON« to switch on the dicta-
tion machine.

— Press the »[=l« button to do the microphone settings
(the current settings are displayed on the right edge)
You can set the microphone sensitivity via »al« (see
chapter ,The menu / Microphone sensitivity").

» Select a sound program on your PC now, e.g. a Grun-
dig dictation software, a voice recognition system or the
Windows audiorecorder.

e Start the recording in your sound program and speak
the message.
— The red LED at the dictation machine lights up, the
disc symbol is spinning.

e Press the »ﬁ« button and hold on pressing it to mute
the microphone.

— No signal is transferred to the recording software,
i.e. a voice recognition system no longer recognizes
any sounds. The red LED is blinking and the disc
symbol stops spinning.

If play-back is running on your sound program or voice
recognition program, the green light emitting diode lights
up and you will listen to the recordings from the speakers
of the Digta.

If you are using the dictation machine as PC microphone
of the Grundig DigtaSoft dictation software, the keys and
slide switch of the dictation machine are programmed with
functions of the dictation software (USB-HID).
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COMMUNICATION WITH THE PC

With the supplied software "AdapterServer" shortcuts and
PC functions may be allocated to the user controls of the
dictation machine for PC microphone operation. Install the
Adapter server and find out more about the configuration
options in its help function or its PDF instruction manual.

Configuration of the dictation accompanying note

The accompanying note for the dictation, as it is called,
contains various information such as the author’s name,
the transcriber’'s name and the type of dictation which
are included with each DSS dictation. You can enter such
information into the completed dictation using the PC soft-
ware. If you want to send all your dictations with the same
information, you can configure your dictation machine
accordingly.

If you are a member of a pre-installed dictation network,
you will find all available settings in the PC software under
»Configuration«. If you are a single user without connection
to a local network, you can create users, dictation types
and groups in the PC software in the »Settings« menu with
the function »General Settings«. You will then be able to
send your name as author, the maximum author priority, 20
transcribers, 20 dictation types and 20 group designations
to your dictation machine under »Configuration«. When
you turn on your dictation machine, your name as author
will be briefly displayed instead of »DICT«. The accompa-
nying note for the dictation may be individually filled in for
each new dictation via the workflow lists.



FIRMWARE UPDATE

The firmware update may be used to keep your dictation
machine in step with the latest developments (firmware =
device software). You will find the current firmware version in
the Internet. The enclosed CD includes the firmware current at
the time of

delivery.

Carrying out a firmware update

Switch on the PC and start Windows.

Use the USB cable to connect the dictation machine to
the PC.

Switch on the dictation machine.

The »« symbol appears on the display of the device

and the dictation machine is identified by the PC as a
removable disk.

You will find the
»gh0421.hex«

file on the »www.grundig-gbs.com« website under
Service/Download/Firmware/ZIP, as well as in the
»Firmware\Digta0421« folder on the provided CD.

Copy this file to the »System« folder in the dictation
machine drive (removable disk).

The dictation machine’s recording LED flashes during
transfer. Wait until data transfer is complete.

Then, from the task bar, select the function ,Savely
Remove Hardware®, as otherwise the transfer may not
be complete.
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FIRMWARE-UPDATE

» Disconnect the USB plug from the dictation machine.

UPDATING

«  Confirm »LOAD UPDATE« with the »V « button.

g Do not interrupt the loading process for any reason.

This could make the dictation machine inoperative.

» Then format the memory in the dictation machine (see
»The menu / Formatting").

I HiNT

If you wish to load an old firmware once again, press the
»new« button and the right selection button simultane-
ously when switching the Digta x420 on.
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DIGTA SCAN 404 BARCODE READER

Using barcodes

You can scan a barcode for each new dictation. The
detected codes are stored in the header of a DSS file in the
“Topic” field, and thus displayed in the note which accom-
panies the dictation. Other programs which evaluate the
DSS header (for example a database system), can classify
the dictations using the codes.

The scanned codes can then be displayed or automati-
cally processed by software that analyzes the DSS header
— e.g. a database system.

The detected codes are displayed by the PC software
supplied with the portable dictation machine and by the
desktop software:

—in the overview of the accompanying note for the
dictation (see also “Dictation accompanying note” in
the program help)

— in the dictation list (if the “Topic” field is enabled, see
“Sorting” in the program help).

I HiNT

We offer a software development kit (SDK) for integra-
tors who want to evaluate the note accompanying the
dictation, for example in order to create links to database
entries.
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DIGTA SCAN 404 BARCODE READER

Plugging in
Both mechanically and electrically, the Digta Scan connec-
tion is designed in the same way as a memory card.
@ wpPorTANT

Only plug in or unplug the Digta Scan when the port-
able dictation machine is switched off.

* Plug the Digta Scan into your dictation machine as
depicted below:

0 IMPORTANT

Make sure that the latch on the back of the Digta Scan
snaps securely in.
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Unplugging
* Remove the locking screw (if present).

* Press the latch on the back of the Digta Scan. The Digta
Scan is unlocked and you can now pull it out of the
memory card slot.

See the illustration on previous page.




DIGTA SCAN 404 BARCODE READER

Switching the Digta Scan on and off

e

Barcode reader BT

Scan workflow

r = =
Scan workrlove

Oon request
~ = "

The Digta Scan must be inserted and latched into the
portable dictation machine.

Only when the Digta Scan is plugged in are the associ-
ated menu items available on the dictation machine.

Switch on the dictation machine.
Push the slide switch to » ISTOP«.
Press the »« button.

Use tht?“"rlravigation buttons » 4» « to select the main
menu »T7« and then press the »V « button.

Use the naV|gat|on buttons » 4» « to select the sub-
menu »ﬁ« and then press the »V « button.

Usle the navigation buttons » 4»« to select »%« or
»%« and then press »W«.

»%« when you create dictations with the »new« but-

ton, you are prompted to scan. You can now scan in
a barcode and store it in the dictation accompanying
note.

—»%«, when you create dictations with the »new«
button, you are not prompted to scan even though
the Digta Scan is plugged in.

B HINT

The selected setting is retained even if the Digta Scan
is removed from the portable dictation machine. How-
ever, you can only change the setting when the Digta
Scan is attached.
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DIGTA SCAN 404 BARCODE READER

Scanning a barcode for a new dictation

Scancode
1034506464020405
6034

'I'_

¥

The Digta Scan must be connected to the portable dicta-
tion machine, enabled and configured for the barcodes
you are using.

» Switch on the dictation machine.
» Push the slide switch to »lISTOP«.

» Press the »new« button.
— >« and »@« appear in the display.

» If you do not want to scan a barcode into the dictation
accompanying note, press the »»4_« button and con-
tinue with your dictation as usual.

» If you want to scan a barcode, point the barcode reader
at the barcode as pictured and press the »V « button.

—The device now scans the code with a red laser
beam. The machine acknowledges the successful
reading of the code with a single signal tone, and the
laser beam shuts off.

— The scanned barcode appeatrs in the display.

» If you want to include the barcode as displayed in the
dictation, press the »\/« button.

» If you do not want to include the barcode in the dicta-
tion, press the »4_« button and continue with your dic-
tation as usual.
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I HiNTS

If the machine cannot read a code, it emits a double
signal and displays the message »Scan fails Repeat ?«.
Confirm the error message and repeat the scan proce-
dure with »V/« or cancel it and continue dictating with-
out barcodes by pressing » 4. «.

A maximum of 32 digits (two lines) of the scanned
barcode can be displayed.

Barcodes that you have scanned and included in
dictations with » V'« are stored in the “Topic” field in the
new dictation’s accompanying note.

Displaying a barcode for a dictation

Scan fails

Repeat?
t od
[Scanner _____ EEES|

[Barcode reader BEEE

Read barcode

o
Display code/new
1034506-1641020105

0034
DICT 0005

Push the slide switch to » IISTOP«.

Use the navigation buttons » €4» « to select the dicta-
tion.

— If the dictation has a barcode, »ID« is displayed.
Press the »[=k button.

Use th?mmavigation buttons » €4 » « to select the main
menu ».« and then press the »\/« button.

Use the navigation buttons » €4» « to select »@« and
then press the »V « button.

— The barcode is displayed.
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Scanning a barcode for an existing dictation

Scanner ______REEE

(=] e

-

Barcode reader SEEE)

Read barcode

Earcode Feader [T
Read barcode

DICTO00E

Earcode reader [T
Barcode read in
1023401040502040
3020405
DICTOOOS

DICTOODS
S

Switch on the dictation machine.
Push the slide switch to » lISTOP«.

Use the navigation buttons » €4» « to select the dicta-
tion for which the barcode is to be scanned.

Press the right button »F=k.

Use th(?mmavigation buttons » €4 » « to select the main
menu »7« and then press the »\/« button.

Use the navigation buttons » €4» « to select »@« and
then press the »V <« button.

— »mmk and »4_« appear in the display, along with the
number of the dictation.

Point the reader at the barcode and press the »(mmk

button.

—The device now scans the code with a red laser
beam. The machine acknowledges the successful
reading of the code with a single signal tone, and the
laser beam shuts off.

— The scanned barcode appears in the display.

If you want to include the barcode as displayed in the
dictation, press the »V « button.

—»ID« is shown in the status bar under the number of
the dictation.
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Searching for a dictation belonging to barcode

Sconner RS

(=] e

e d

Barcode reader S|

Search dictation

1 JE R

= o =

Barcode reader S|

Search dictation

A01EI15501002

~ [

Switch on the dictation machine.
Push the slide switch to » ISTOP«.
Press the »»[=k button.

Use the navigation buttons » €4» « to select »%« and
then press the »V « button.

Use the navigation buttons » €4» « to select et and
then press the »V « button.

Point the reader at the barcode and press the »mmbut-
ton.

— The scanned barcode appears in the display.
Press »V « to confirm the barcode.

— The number of the dictation is shown under the bar-
code.

To listen to the dictation, press »W« again and push the
slide switch to » P PLAY«.
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Deleting a barcode from a dictation
 Push the slide switch to »BISTOP«.

EETTTTEEE <=~ . (Jse the navigation buttons » 4 » « to select the dicta-
tion whose barcode is to be deleted.

+ Press the »I'=k button.

* Use the navigation buttons » 4 » « to select »%« and
then press the »V « button.

[Barcode reader BEEE] L
Delete code » Use the navigation buttons » €4 » « to select »M« and

then press the »V « button.

vy
=

— The barcode and the dictation number are displayed.

e Press »\/« to delete the barcode.

Earcode reader
Delete code
1023401040502040
3020405

DICTOOOS
t pd
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Configuring the Digta Scan barcode reader

Default symbologies

In the default setting, only barcode symbology EAN-13 is

enabled.

If you use different symbologies, you can configure the

Digta Scan to work with them.

If you would like to optimize the code recognition, we rec-
ommend that you enable only those symbologies that you
actually use. The lower risk of confusion increases the

recognition accuracy.

Programming code table

We provide a table with programming codes in barcode

format.
You can open this PDF table with Acrobat Reader*.

You can print the required programming codes and then
use them to configure the barcode reader. If the table is not
supplied with your Digta Scan or you need codes it does

not contain, please visit our Internet download centre:
http://www.grundig-gbs.com

Our Internet site also lists our Customer Service address

and hotline number.

* Download for free at http://www.adobe.de/products/

acrobat/readstep.html
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Preparing settings
You can change the symbology settings (see also “Default
symbologies”) as follows:

* Print out the required programming codes from the
programming code table.

— There are usually two programming codes displayed
for the usable barcode symbologies; the upper for
activation (ENABLE) and the lower for deactivation
(DISABLE).

— Use a laser printer, for example, in order to obtain a
legible printout.
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Setting the Digta Scan barcode reader

Barcode reader [EEE)

Programming

Scan fails
Repeat?

t ¥

The Digta Scan must be inserted and latched into
the portable dictation machine (see also “Plugging in,
Unplugging”).

—Only when the Digta Scan is plugged in are the
associated menu items available on the dictation
machine.

Switch on the dictation machine.
Push the slide switch to » IISTOP«.
Press the »I=k button.

Use the navigation buttons » €4» « to select »%« and
then press the »V « button.

Use the navigation buttons » €4 » « to select ¥

— The »Programming« menu function appears in the
display.

B HINT

»X «, see also “Restoring the default settings”.

Scan in the programming code with the »fmik button.

— The machine acknowledges the successful reading of
the code with a single signal tone.

—You can scan any number of programming codes
consecutively with the »fmik button.

I HINT

If the machine cannot read a code, it emits a double
signal and displays the message »Scan fails Repeat ?«.
Confirm the error message with »V .

Once you have made all the settings, press the »4_«
button to quit the menu.
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Restoring the default settings
You can restore the Digta Scan’'s default settings.

Barcode reader [EEEE

Programming

vy fon i
et

Earcode Feader frr
Programming

L A [

Reset scanner
Deactivate

all e
batcodes

© ¥

If you do so, all barcode symbologies are disabled except

for EAN-13.

The Digta Scan must be inserted and latched into
the portable dictation machine (see also “Plugging in,
Unplugging”).

—Only when the Digta Scan is plugged in are the
associated menu items available on the dictation
machine.

Switch on the dictation machine.
Push the slide switch to » ISTOP«.
Press the »[=k button.

Use the navigation buttons » €4» « to select »%« and
then press the »V « button.

Use the navigation buttons » €4 » « to select » i

—The »Programming« menu function appears in the
display.

Press the »X« button.
— »Deactivate all barcodes ?« appears in the display.

Press the »V « button to leave only symbology EAN-
13 enabled. Press the »4_« button if you would like to
keep the other symbologies enabled.

Once you have made all the settings, press the »4_«
button to quit the menu.
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Using RFID codes
RFID codes are located on RFID labels (TAG).

You can scan a RFID code for each new dictation. The
detected codes are stored in the header of a DSS file
in the “Subject” field, and thus displayed in the note
Ll that accompanies the dictation. Other programs that
evaluate the DSS header (for example a database
system) can classify the dictations according to the
scanned codes.

The detected codes are displayed by the PC software

included with the portable dictation machine and by the

desktop software:

—in the overview of the accompanying note for the
dictation (see also “Dictation accompanying note” in
the program help)

—in the dictation list (if the “Subject” field is enabled,
see “Sorting” in the program help).

Connecting and removing the RFID reader

The same procedure is used as with barcode reader 404.
See the Chapter “Plugging in” and “Unplugging”.
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Turning the RFID Reader on and off

* The RFID Reader must be plugged into the portable
dictation machine and locked.
Only if the RFID Reader is plugged in will you be able
to select the associated menu items available on the
dictation machine.

e Switch on the dictation machine.
» Push the slide switch to »lISTOP«.
«  Press the »=k button.

» Use the navigation buttons » 4 » « to select »%« and
+ = - then press the »\/« button.

* Use the navigation buttons » €4 « to select »%« and
— then press the »V « button.

Scan workflow

@ s | . Usle the navigation buttons » 4» « to select P« OF
=i i« and then press »OK.

r = = - »%«, when you create a dictation with the »new«
button, you will be prompted to it. You can now scan a
2can workiiov TR RFID code and store it in the dictation accompanying
Oon request note.

s @ — »}¥, when you create a dictation with the »new«
button, you will not be prompted to scan it, although

v = -« the RFID Reader is connected.

B HINT

The selected setting is retained even if the RFID Rea-
der is temporarily removed from the portable dictation
machine. However, you can only use or change the
setting if the RFID Reader is connected.
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Scanning a RFID code for a new dictation

Scancode

1436024656

i od

Scan fails
Repeat?

t ¥

The RFID Reader is connected to the portable dictation
machine and activated.

e Switch on the dictation machine.
» Push the slide switch to »ISTOP«.

* Press the »new« button.
— >« and »@« appear in the display.

» If you do not want to scan a RFID code into the dic-
tation accompanying note, press the »4_« button and
continue with your dictation as usual.

» If you wish to scan a RFID code, hold the RFID Reader
directly at the label with the RFID code (see illustration)
and press the »V « button.

— The device will now scan the RFID code. If the RFID
code was successfully scanned, the device will ack-
nowledge this by emitting a single tone.

— The RFID code appears in the display.

» If you want to include the RFID code as displayed in the
dictation, press the »V « button.

» If you do not want to include the RFID code in the dic-
tation, press the »4_« button and continue with your
dictation as usual.

B HINT

If the machine cannot read the RFID code, it emits a
double signal tone, and the message »Scan fails
Repeat ?« appears in the display. You can now repeat
the scan with the »V « button or cancel it with the » 4. «
button and dictate without a RFID code.
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B HINT
A maximum of 32 digits (two lines) of the scanned
RFID code can be displayed.

RFID code that you have scanned and included in
dictations with »V « are stored in the “Topic” field in the
new dictation’s accompanying note.

Additional functions

FFIL FES0er [T
Search RFID code

B9

N

The RFID Reader has the same functions as the barcode
reader.

See the chapters on the barcode reader for furthﬁI informa-
tion on operation. The menu is located under »F«.

— View the RFID code of a dictation;

— Scan the RFID code for an existing dictation;
— Search the dictation for a RFID code;

— Delete the RFID code of a dictation.
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No
memory

1537

1538

1570

1584

1585

1610

»Dictation cannot be created« — Error in the file
system of the internal memory or the external
memory card.

Remedy: Format the internal memory or memory
card.

»Dictation cannot be created« — Error in the file
system of the internal memory or the external
memory card.

Remedy: Format the internal memory or memory
card.

»Index/Info full« — The maximum permitted quantity
of information or indices has been reached. It is not
possible to add more information or indices.

Remedy: Delete information or an index.

»NOT SUPPORTED DSS FORMAT« — A dictation
in this DSS format cannot be played back.

Remedy: Play back the dictation on another
dictation machine or on the PC. If available load
new firmware which is able to play back this DSS
format.

»NOT SUPPORTED DSS FORMAT« — The
folder you selected doesn‘t contain a dictation
in the supported DSS format.

Remedy: Select another folder with the dictation in
another DSS format. Play back the dictation on
another dictation machine or on the PC. If availible
load new firmware which is able to play back this
DSS format.

»Delete other files?« — When deleting entire fold-
ers or formatting the memory, the machine finds
files that are not DSS dictations and cannot be
displayed (e.g. ds2, doc).

Remedy: Cancel the function if you do not want to
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1611

1612

1613

2821

delete these files. Transfer the files to a computer
and then perform the deletion or formatting function.

»PLAY-BACK ONLY« — The dictation machine
is set to play-back with foot control and is in the
Digta Station. Dictations are protected from being
edited.

Remedy: Use the »Foot control« menu function
to set the device to record in the Digta Station. Or
remove the machine from the Digta Station.

»Data list wrong format« — Failures were noted dur-
ing the reading process. The data list has not been
transferred.

Remedy: Please check the contents of the
ids.csv-file, if semicolons, commas or word wraps
are missing. The individual data is limited to a maxi-
mum of 256 characters. The columns of the data
set are limited to 128.

»Data list too long« — The data list cannot be read
in because the size of the data list is too large.

Remedy: Check the size of the ids.csv file. The
maximum file size is 16 K Bytes. The number of
columns is limited to 128.

»Duplicate name after renaming« — A dictation is to
be renamed. There is however already a dictation
with this name.

Example: There are the dictations DICT0001.dss
and DICT0001.ds2. The dictation DICT0O001.dss
should be encrypted afterwards. It would then also
be named DICT0001.ds2.

Remedy: Connect the dictation device to the PC
via USB. Rename the first dictation with the help of
DigtaSoft or Windows Explorer. Then encrypt the
second dictation.
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8321

8322

8323

9734

9746

9749

9750

»BATTERY LOW« — Battery voltage too low for
updating the firmware.

Remedy: Recharge the batteries or operate the
dictation machine powered from the USB port on
your PC.

»BATTERY LOW« — Battery voltage too low for
formatting.

Remedy: Recharge the batteries or operate the dic-
tation machine powered from the USB port on your
PC.

»BATTERY LOW« — Battery voltage too low for
restoring the default settings..

Remedy: Recharge the batteries or operate the dic-
tation machine powered from the USB port on your
PC.

»FILE READ ONLY« — Dictation lock (write/erase
protection) activated.

Remedy: Disable dictation lock in the Delete menu.
Disable write/erase protection in the accompanying
note of the dictation.

»STARTBMP ERROR« — Defective start logo.

Remedy: The start logo file is unlike startbmp.bmp or
it contains errors. Use another revised startbmp.bmp
file

»DELETE NOT POSSIBLE« — Error when deleting
a dictation.

Remedy: Delete via USB with DigtaSoft or Windows
Explorer on your PC.

»NO MEMORY« — Memory full > Recording termin-
ated.

Remedy: Delete some dictations. Delete other files
(for eg. .doc, .ppt) if existing.
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9751

9753

9756

9758

9762

9782

9795

9796

»NO MEMORY« — Recording has not started
because of a full memory.

Remedy: Delete some dictations. Delete other files
(for eg. .doc, .ppt) if existing.

»FIRMWARE INCORRECT« — The gh0420.hex
firmware file contains false data (e.g. firmware of
another device).

Remedy: Perform an update with another
gh0420.hex.

»NO MEMORY« — Partial deletion has not started,
since there is insufficient memory for temporary
storage.

Remedy: Delete a different dictation first. Delete any
foreign files (e.g. doc, ppt).

»NO PART TO DELETE« — Partial deletion is not
possible.

Remedy: Select a section for deletion.

»FILE READ ONLY« — Erasure-protected dictations
are in the folder to be deleted.

Remedy: Disable the dictation lock in the Delete
menu. Disable write/erase protection in the accom-
panying note for the dictation.

»DEL PART WITH INDEX« — The dictation section
marked for deletion contains an index. For this rea-
son, this section of the dictation cannot be deleted.

Remedy: Delete the index and then the dictation
section.

»NO MEMORY« — Not enough free memory.

Remedy: Delete dictations to have more memory
available for the desired functions.

»FILE READ ONLY« — The dictation lock (write /
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erasure protection) is activated.

9801

17674

17936

17937

17940

17944

Remedy: Disable the dictation lock in the Delete
menu. Disable write/erase protection in the accom-
panying note for the dictation.

»INSERT TO INFO FORBIDDEN« — The current
position of the dictation is contained in an informa-
tion. It is not possible to insert into information.

Remedy: Delete the information and dictate a new
one.

»CARD NOT SUPPORTED« - If you use
MultiMediaCards/SecureDigital Cards (MMC/SD)
with insufficient writing speed, »Card not sup-
ported« appears in the display.

Remedy: Use a Digta Card by Grundig Business
Systems.

»UPDATE FILE ERROR« — Error of the firmware
update.

Remedy: File error of the firmware gh0420.hex
(false check sum). Update with another
gh0420.hex file.

»UPDATE VERSION ERROR« — This version of the
firmware file is not loadable on this Digta.

Remedy: Update with another version of the
gh0420.hex file.

»FAT Errorl« — The directory of the files could not be
stored in the memory. Maybe the recording function
was still active when removing the memory card.
Remedy: Switch the device off and switch it back
on again. When this message pops up again, all
dictations have to be deleted through formatting
the memory.

»DOWNGRADE, NO UPDATE« — The firmware ver-
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17990

17991

17992

17993

26181

sion to be loaded in the Digta is older than the current
version of the Digta.

Remedy: If you wish to load an old firmware, press
the »new« button and the right selection button
simultaneously when switching the Digta on.

»FAT NOT SUPPORTED« — The internal memory
or external memory card has been formatted incor-
rectly (e.g. FAT32).

Remedy: Format the internal memory or external
memory card.

»MEDIANOT SUPPORTED« — The MMC/SD mem-
ory card is not supported, e.g. a card with more than
2 GB.

Remedy: Use a Digta Card by Grundig Business
Systems.

»MEDIA DAMAGED« — The internal memory or
external memory card is faulty.

Remedy: Replace old MMC/SD cards with new
Digta Cards. If the internal memory is faulty, the
machine has to be repaired.

»CARD NOT SUPPORTED« — If you use
MultiMediaCards/SecureDigital Cards (MMC/SD)
with a too low writing speed »card not supported!«
appears in the display.

Remedy: Use a Digta Card from Grundig Business
Systems.

»WRITE TOO LONG« — Writing to the internal
memory or external memory card during dictation
takes too long due to faulty memory cells. The
memory is too old.

Remedy: You can continue using the machine if the
message does not occur frequently. Replace old
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MMC/SD cards with new Digta Cards.

»EXT NO PIN PROTECTION« — Dictations on
external memory cards (Digta Card) cannot be pro-
tected using the PIN/PUK* function.

Remedy: Press the right-hand selection button »W«
to confirm that you want to use an external memory
card without PIN* protection.

»DEVICE LOCKED« — The PIN was entered incor-
rectly nine times.

Remedy: Enter PUK.

»NO FIRMWARE« — If an old firmware version is
needed (when the machine is switched on, the right
selection key and the “new” button are pressed at
the same time ) no firmware file is found.

Remedy: Copy a file with the name gh0420.hex into
the SYSTEM folder and start the load of the old ver-
sion afterwards.

All messages with different numbers and the display
“UNKNOWN ERROR”:

Turn the dictation machine off and then back on. If the
machine does not turn on normally, take out the batteries
and then reinsert them. Turn the machine then back on. If
the error message still appears, please contact your dealer
or technical customer service. You can help the customer
service solve your problem much more quickly if you report
the steps taken to produce the error and the error number
displayed.

Hotline, E-Mail:

www.grundig-gbs.com under Support/Contact info
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